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1	Software Overview
Direct Detect™ Spectrometer Software is an application program designed for the Windows® 7 
operating system and comes pre-installed on the Netbook computer.

1.1	 Program Startup and Login
The Direct Detect™ instrument must be connected to the computer and a power source 
before starting the Direct Detect™ software (refer section 6.5 in the Direct Detect™ 
Spectrometer User Guide). 

To start the software, click on the Direct Detect™ icon on the desktop. The software 
can also be accessed from the “Start” menu and taskbar.

WARNING: Do not install third-party software (screen savers, etc.) as this may impact the 
performance of the Direct Detect™ system.

During startup the title screen will be displayed. The initialization of the connections to 
the instrument is configured during the display of the title screen.

Figure 1.  Direct Detect™ startup screen

After loading the analysis engine you should hear an audible tone from the instrument to 
indicate that communication has been established.

If a message appears indicating the software is not able to communicate with the 
instrument, confirm that the instrument is powered up, that the RJ45 cable is connected 
between the instrument and PC.

After the software initialization is complete the login dialog appears.

Figure 2.  Direct Detect™ login screen

Each user can be assigned a unique name and optional password. The measurements 
performed by each user are stored and recalled based upon the user name. Certain 
customization settings are also stored on a per user basis.
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Users can be assigned one of two privilege levels; Operator or Administrator. 
Administrators have full access to all program features while operators are restricted to 
sample measurement and analysis only.

By default two users are created. The generic user name “Operator” is a pre-defined 
operator who has basic sample measurement and analysis capabilities. No password is 
required for the generic operator.

The “Administrator” user name allows you to login into the User Management screen 
(section 1.2). This screen is used to assign new users and set their privilege level and 
password.

To log into the program, enter or select a user name from the “User Name” field. Only 
previously defined users can be entered or selected. The privilege level for the selected user 
is displayed in braces above the field.

If a password has been assigned to the selected user, then the password field becomes 
active. You must enter the correct password (not case sensitive).

Press enter or select the “OK” button to login in. After a few moments the main program 
screen should appear.

Select the “Logout” option from the “File” menu (Ctrl-L) to logout of the main screen and 
return to the login screen.

1.2	 User Management
The User Management dialog is used to create, update, or delete users of the Direct 
Detect™ software. The functions in this section are accessible to users with “Administrator” 
privilege only.

Figure 3.  User management dialog

The User Management dialog is accessible from the login screen by selecting the 
“Administrator” user name. The default password for the administrator is “directdetect”.

The User Management dialog is also accessible from the main screen by selecting “User 
Management” from the “Options” menu. This option is only available to users with 
administrator privileges.

1.1	 Program Startup and Login, continued
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The User Management dialog has a list of currently defined users on the left side of the 
dialog, and controls to add, update, or delete users to the right. Left click on a user’s name 
in the list and the current settings for that user appear in the controls on the right.

The “Administrator” password can be modified to prevent access to the User Management 
screen from login. To restore the default password either type it as the password for the 
administrator, or leave the password field blank and the software will ask you if you want 
to reset the password to the default.

Adding a new user:
To create a new user, enter a unique name in the “User Name” field. If you want to 
password protect this user enter a password in the “Password” field, otherwise leave the 
field blank.

Select whether you want this user to have administrative rights which 
grant access to administrative functions, or to limit the user’s access to 
sample acquisition and analysis.

Select the “Add” button to add this new user to the list of user names.

Modify a user:

To change a user’s password or privilege level, first select their user name from 
the list, and then make the desired changes. When complete select the 
“Update” button to save the changes.

Deleting a user:

To delete a user first select the user name from the list and then select the 
“Delete” button. This will delete the user but not the data files or database 
created by the user during sample acquisition and analysis.

Normally the user’s password is masked by asterisks. Check the “Show 
Password” option to display the password.

1.2	 User Management, continued
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1.3	 Main Screen Layout

Figure 4.  Main Direct Detect™ screen

The main Direct Detect™ screen is used to perform all sample measurement analyses. The 
screen is divided into five regions.

Figure 5.  Main screen regions

Sample Information: 
This section defines the sampling parameters. Fields and options in this section 
must be defined before sample measurement can commence.

Sample Measurement:
This section starts the sample measurement and provides feedback to the user 
during the measurement cycle.
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Measurement Results:
This section contains two tabs. The “Last Sample Results” tab displays the results 
from the last sample card measured, or the results from the sample card that was 
displayed using the “Load History” button on the “Card History” tab.

Graphics & Analysis:
This section contains three tabs to display either the spectral plot for a specific 
region or a calibration curve plot, or a statistics grid of past results.

Diagnostics:
This section contains three buttons. The top button displays the program 
information. The other two buttons display instrument validation and hardware 
diagnostics respectively. The icon and tooltip indicate the current state of these 
diagnostics. Selecting either button opens a dialog with more detailed information.

The top half of the screen can be hidden to allow more screen space for 
the bottom section. To hide the top half of the screen left-click on the 
center of the divider. The bottom half of the screen will expand to cover 
the entire program screen. Click the center divider again to return the 
screen layout to the default.

The bottom half of the screen also contains a horizontal divider which can be 
dragged left or right to reveal more or less of each region. Place the mouse 
pointer over the center of the divider. The pointer will change shape. Left-click 
and hold the mouse down to drag the divider left or right.

1.3	 Main Screen Layout, continued
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1.4	 Instrument Operation
The Direct Detect™ spectrometer measures the near-infrared spectrum of the energy that 
passes through the protein sample. The chemical composition of the sample is defined by 
the amount of energy absorbed at specific frequencies, or wavenumbers, of energy.

Samples are introduced using the Assay-free sample card. The card contains four polymer 
membrane sample positions. An alignment notch in one corner of the card prevents 
incorrect card insertion into the card holder.

Figure 6.  Sample card

By default, the bottom position 1 (closest to the notch) is reserved for the “blank” 
measurement. The “blank” is the buffer solution without a protein sample. One or more of 
the remaining positions can be used for samples.

Refer to the section 10.2 in the Direct Detect™ Spectrometer User Guide for detailed 
instructions on loading and installing the Assay-free sample card. Apply exactly 2 µL of 
solution to the blank and sample positions.

Figure 7.  Sample card spotting

Insert the card vertically into the slot in the top of the card holder (Figure 8). The card 
notch should face towards the center of the instrument.
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Figure 8.  Inserting sample card

When the card is inserted properly the instrument will respond by jogging the card holder 
up and down briefly. The bottom green LED on the card holder module will light and the 
system will produce a brief tone. If this does not occur, check the card orientation. The 
software will not allow sample measurement if the card is not inserted properly.

The top of the card holder module contains two LED lights located in the bottom right 
corner (as viewed from the top).

Figure 9.  Top view card holder module

Sample drying indicator light

Card insertion light

The bottom LED (green) is lit whenever a sample card is inserted properly.

The top LED (yellow) is lit whenever the drying system heater and fan are active.

Periodically the software will perform a reference measurement which must be performed 
without a sample card inserted in the card holder. If a card is found in the card holder the 
software will prompt you to remove it.

Important: A seven minute warm-up cycle is required after initial power-up and software 
activation. The software will wait for seven minutes before allowing a sample 
measurement to begin.

1.4	 Instrument Operation, continued
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2	Sample Measurement
2.1	 Reference Measurements

After login to the main screen the software will automatically attempt to perform a 
reference measurement. This is an internal instrument measurement which subtracts 
the effects of atmospheric conditions, internal components, etc., from the resultant 
sample spectrum. A sample card should not be inserted into the card holder while this 
measurement is in progress.

If there is a sample card in the card holder when an automatic reference measurement 
begins, a popup dialog will appear requesting that you cancel your measurement so that 
the reference measurement can begin.

Figure 10.  Cancel Card Measurement warning

During the automatic reference measurement a progress dialog will appear. Program 
access is restricted while the reference measurement is in progress. Do not move, handle, 
or jostle the instrument while the measurement is in progress.

Figure 11.  Reference measurement progress dialog

Once the reference measurement is complete normal program operation can continue. 
The reference measurement will occur again when the interval defined in the Program 
Settings screen (section 7.1) has expired. The factory-set default setting is 15 minutes.
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2.2	 Sample Measurement Setup
To perform a sample measurement, prepare the sample card as directed in section 10.2 of 
the Direct Detect™ Spectrometer User Guide, then complete the fields and options in the 
sample information region of the main screen.

NOTE: If you choose not to use one of the three preloaded calibration methods, a calibra-
tion method must be created prior to reading samples (see Calibration Method, 
section 4.2).

Figure 12.  Sample information region

Each sample card measured requires at least one “Blank” position to be defined. The 
blank contains the buffer solution used to prepare the samples, but has no protein in it. A 
previously measured “Blank” can be reused if desired (see option “Use last blank” below). 
The blank measurement is subtracted from the sample measurement(s) prior to sample 
analysis.

User Name:
This field is not editable and contains the logged in user name.

Card Name:
Enter a name or identifier for the current sample card.

Method:
This field is a drop-down list of available calibration methods. By default the files are 
located in “Libraries” (Libraries\Documents\My Documents\Direct Detect\Methods). Three 
preloaded calibration method files are available (NIST BSA AM1.q3, NIST BSA AM2.q3, and 
NIST BSA AM3.q3; refer to section 4.2 for details).

If desired use the  button to select a different folder containing Direct Detect™ 
calibration method files. A folder selection dialog will open to select a new folder.

Below the method field is a description of the method file. Placing the mouse over the 
description displays the full text of the description in a popup tooltip.
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Use last blank:
With this option selected, the last blank collected by the instrument will be used. This 
allows you to designate all four positions on the card as samples. This option is not 
available if a previous blank measurement was not performed.

Figure 13.  Use last blank option

With this option selected an info icon will appear. Click on the icon to view details 
about the blank that will be used.

If you wish to use a previously collected blank other than the last one collected, go to the 
“Options” menu and choose the “Select Blank File” option (Figure 14). A dialog containing 
a list of all blank files measured by the current user is presented, with the most recently 
measured blank at the top of the list.

Figure 14.  Select blank dialog

Select an entry from the list and press the button. The dialog will close and the 
“Use Last Blank” option will be automatically selected.

2.2	 Sample Measurement Setup, continued
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Dry sample card:
The option is checked by default and enables the software to perform the card drying 
routine prior to card measurement and analysis. You can override the “Dry sample card” 
action by unchecking this option if the sample card has been previously dried, but it is not 
recommended.

Defining samples:
The right side of the sample information screen contains fields for defining the individual 
sample positions for the sample card to be measured.

Figure 15.  Sample definition fields

Four colored circles represent the four sample card positions. By default the bottom 
position is designated as a blank position. The color of the circle indicates the use of the 
sample position. Click on the sample position to change it to the desired designation 
(blank, sample, or unused).

A blue circle indicates a blank (buffer) position.

A green circle indicates a sample position.

A white circle is an unused position.

Blank and sample positions require a sample name.

If a required field has not been defined, a red circle with an exclamation mark will appear 
next to the field that is missing when you attempt to start a measurement cycle.

Card positions are measured in numerical order.

Defining a card blank position:
By default the blank position is defined as position #1 on the sample card. The actual 
position can be defined as any one of the four card positions. 

2.2	 Sample Measurement Setup, continued
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More than one “Blank” position can be defined if desired. Below is an example illustrating 
the behavior if more than one blank position has been defined.

Example:

The blank position with the lowest position number will be measured first. In this 
example position 1 is the first defined blank position. If position 3 was the only 
defined blank then the software would start with position 3 before returning to 
the lowest to highest numbering scheme. 

Position 2 will have the blank from position 1 subtracted from it. 

Position 3 will be measured as a blank.

Position 4 will have the blank from position 3 subtracted from it. 

2.3	 Sample Measurement
After completing the sample measurement setup (section 2.2), and preparing the sample 
card, you are ready to begin sample measurement.

Insert the sample card into the slot (refer to section 1.4).

The sample measurement region of the screen (Figure 16) contains a colored text status 
field with a progress bar beneath.

Figure 16.  Sample measurement region

Select the button to start the measurement cycle. After checking for required 
parameters the measurement cycle will begin.

The system requires a seven minute warm-up period from the time that the instrument is 
powered before a measurement cycle can be performed. If the warm-up period has not 
been completed, the status bar will turn yellow and 
count down the number of remaining seconds before the measurement cycle can begin.

NOTE: The instrument is powered through the computer and does not have a separate 
ON/OFF switch. It should be left on and powered up at all times. The seven minute 
warm-up is required only after the instrument has been powered down.

The Direct Detect™ instrument will position the sample card at the first defined blank 
position (unless the option to “Use last blank” has been checked) starting at the bottom of 
the sample card (card position 1).

2.2	 Sample Measurement Setup, continued
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If the option “Dry sample card” is checked, the instrument will perform the drying routine. 
The drying fan will start and the yellow LED on the instrument will light.

Figure 17.  Drying cycle in progress

The first sample position will typically take the longest period of time to dry, with 
subsequent positions taking less time.

The status field will indicate which sample position is being dried. If the drying cycle 
reaches its defined limit for cycles (section 7.1), a warning message will appear.

Figure 18.  Drying cycle warning

For samples with a viscosity higher than water (e.g., when glycerol is present), the drying 
time may exceed the defined time limit. You can continue the drying cycle by selecting the 
“OK” button, or abort the measurement cycle using the “Cancel” button.

When the drying cycle has finished (unless it was not performed) the sample measurement 
cycle will commence. The sample data is acquired and analyzed. The progress bar indicates 
the acquisition progress.

Figure 19.  Sample measurement cycle

You can abort the measurement cycle at any time by selecting the button. The 
active measurement will be completed before the cycle is aborted and the data will be 
saved.

The result for each individual sample position is recorded in the “Last Sample Results” tab 
(section 2.4) of the Measurement Results region of the main screen. It can also be viewed 
and recalled in the “Card History” tab (section 3.1). The spectrum plot and calibration 
curves are plotted as well (sections 2.5 and 2.6).

2.3	 Sample Measurement, continued

Direct Detect™ Spectrometer Software User Guide 13



2.4	 Sample Results
The results from each measured sample position are displayed on the “Last Sample Results” 
tab. The tab is divided into two sections.

The top section shows the card information, including the name, measurement date and 
time, and the computed concentration value (mg/mL) for each sample position (Figure 20). 
The color box to the left of the concentration matches the color of the plotted spectrum 
and calibration curve point. The sample position name is to the right of the concentration 
value. For positions that are defined as blank or not used the concentration value is “----“.

The bottom section displays the computed average concentration, standard deviation, and 
% CV (coefficient of variation) for the measured sample positions on the sample card.

Figure 20.  Last sample results tab

Sample card information

Sample card statistics

To remove one or more of the positions from the statistics, hold the control key and left 
click the sample position circle. The circle color will change to light red (Figure 21). Click 
again to return it to the measured color and include the result in the statistics.

Figure 21.  Last results statistics

When the measurement cycle is complete, select the button to create a single page 
report for this sample card. This is the same as selecting “Print Loaded Record” from the 
“File” menu (section 6.1).
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2.5	 Spectrum Plot
In the Graphics & Analysis region of the screen, the sample card analysis results are 
displayed as a plot of the spectral data within previously defined regions.

Figure 22.  Spectrum plot

Four previously configured spectral regions can be viewed using the tabs along the bottom 
of the plot. The “Protein” region is selected by default. Select any of the other tabs to view 
those regions instead.

By default the chart shows the spectral plots for all sample positions measured on the 
sample card. The blank position(s) can be displayed as well (section 7.1).

The upper-left corner of the plot displays the card name and starting date and time for the 
card measurement and analysis.

Each sample position is color-coded and matches the color markers displayed on the “Last 
Sample Results” tab.

Right clicking the mouse on the spectrum plot displays a popup menu of options for the plot.

Figure 23.  Spectrum plot menu

Display Legend:
Selecting this option toggles the display of the chart legend. With the legend 
visible you can hide individual sample plots by unchecking the box to the left of 
the sample position name.
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Display Toolbar:
Selecting this option toggles display of a toolbar with chart options. This 
option is available on the “Options” menu as well. Use the hot key 
combination “Ctrl-T” to toggle this option.

Saves the chart as a bitmap image file.
Copies an image of the chart to the clipboard.
Prints the chart to the default printer.
Displays a printer preview of the chart.

Enable Zooming:
Selecting this option enables chart zooming. Zooming is performed by dragging a box 
around the area you wish to zoom into, starting from the top-left corner and ending at the 
bottom-right corner. This option is available on the “Options” menu as well. Use the hot 
key combination “Ctrl-Z” to toggle this option. 

Figure 24.  Chart zooming

To reset the zoom press the “Esc” key. 

When the chart has been expanded, horizontal and vertical scroll bars appear and allow 
navigation around the chart.

Figure 25.  Chart expanded

Small buttons on the ends of the scroll bars zoom the chart out in discreet increments.

2.5	 Spectrum Plot, continued
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Display Chart Breaks:
When enabled, the “Display Chart Breaks” option changes the scale of a full spectrum plot 
by hiding a defined high absorbance region related to the card material (Figure 26.)

Figure 26.  Full spectrum without chart breaks (left) and with chart  
breaks enabled (right)

Display Analysis Region:
Selecting this option highlights the region of the spectrum that is used to compute the 
concentration values. This is purely a visual aid when examining the spectrum.

Figure 27.  Analysis region

2.5	 Spectrum Plot, continued
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2.6	 Curves Plot
The “Curves Plot” tab contains a single plotted point for each concentration value 
computed on the sample card. The color of each point matches the color indicator 
displayed on the “Last Sample Results” tab (section 2.4).

Figure 28.  Curve plot

This plot is based on the calibration method used during sample analysis.

The equation for the line is displayed in the bottom-left corner of the plot and indicates 
the ideal concentration values per amide signal. The correlation coefficient (R2) for this 
method is displayed in the bottom-right corner of the plot.

Zooming for this chart is accomplished by dragging a box around the area you wish to 
zoom into, starting from the top-left corner and ending at the bottom-right corner.

Figure 29.  Curve plot zoomed

To reset the zoom press the “Esc” key.

When the chart has been expanded, horizontal and vertical scroll bars appear and allow 
navigation around the chart.

Small buttons on the ends of the scroll bars zoom the chart out in discreet increments.

Right click the chart to view a popup menu of options.
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Display Toolbar:
Selecting this option displays a toolbar with chart options. It is available 
on the “Options” menu as well, using the hot key combination “Ctrl-T”.

Saves the chart as a bitmap image file.
Copies an image of the chart to the clipboard.
Prints the chart to the default printer.
Displays a printer preview of the chart.

Configure Plot Limits:
This option displays a dialog that allows selection of high and low limits for plotting the 
concentration values. 

Figure 30.  Plot limits

The default range is 0–10 mg/mL. Enter a new range and select “OK” to apply.

You can reset the range back to the defaults using the “Reset” button.

NOTE: This limit will change automatically if a calibration above 10 mg/mL is performed, 
or if the protein concentration detected exceeds 10 mg/mL.

2.6	 Curves Plot, continued
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3	Post Analysis
3.1	 Card History

The “Card History” tab contains two linked data tables which display the raw results 
from all previous sample measurements for the current user. Each user has a separately 
maintained database of results.

Figure 31.  Card history tab

The bottom table is the list of cards measured with the most recent measurement at the 
top of the list.

Left click on any record in the bottom table to view the individual result for each sample 
position on the card in the top table. Only one set of card results can be displayed in the 
top table. 

If a sample spectra file is missing from the hard 
drive, the file name entry will be highlighted in 
red.

Right click on either table to view a popup menu of options. For the top table, the options 
allow you to toggle which columns of data are visible in the table. This selection is user 
specific and is stored and recalled for the current user.

The bottom table also contains a set of data display 
filters in the popup menu.

Starting Now:
Clears the list of records from the bottom table and only new records stored after the 
current date and time will be displayed.
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Hide Selected:
Hides one or more individual records from view. Hold the control key while left clicking on 
records to select individual records, or hold the left shift key to select a range of records. 
Use the hot key combination of “Ctrl-H” to hide the selected records.

Reset Filters:
Resets the actions of the previous two filters.

This creates a PDF format report with one or more records depending 
upon which records were selected.

Selecting this button loads the selected record (one only) into the “Last 
Sample Result” tab, the “Spectrum Plot” tab, and the “Curves Plot” tab.

3.2	 Card Statistics
The “Statistics” tab is a table of results from multiple sample cards. Each row in the table 
is one sample position result.

Figure 32.  Statistics tab

Adding records to this table generates the same statistics displayed on the “Last Sample 
Results” tab, but for multiple cards instead of just one card.

The information in the table can be saved to a Microsoft® Excel® format spreadsheet file.

Adding Records to the Table:
Records are added to the table by using the drag-and-drop method of transferring records 
from either the bottom card history table (to transfer an entire card’s worth of data), or by 
dragging individual sample position results from the top card history table.

3.1	 Card History, continued
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Figure 33.  Adding records to the table

Highlight the cards or samples to transfer using the Ctrl and Shift key combinations 
(Figure 33). Place the mouse pointer at the bottom edge of the last record selected; the 
mouse pointer will now change shape to include a dotted box below the cursor. Hold the 
left mouse button down and drag it onto the Statistics table before releasing the mouse 
button. The record information will be added to the grid.

Editing Records:
Right mouse click the Statistics table to view a popup menu of options.

Figure 34.  Statistics popup menu

Displayed Columns:
Toggles which columns of data are visible in the grid.

Export:
Saves the current table as a Microsoft® Excel® format spreadsheet file. A dialog 
will open to select the file name and location. Only the visible columns are saved 
to the spreadsheet.

Remove Selected:
To remove rows from the Statistics table, highlight the desired rows using the Ctrl 
and Shift key combinations, and then select “Remove Selected”. The records will be 
removed from the table (but not from the database).

Remove All:
Select this option to remove all records from the Statistics table.

3.2	 Card Statistics, continued
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4	Administrative Functions
All functions in this section are accessible to users with “Administrator” privilege only.

4.1	 Drying Calibration
The Drying Calibration function is used to calibrate the drying routine used for sample 
measurement. The default drying routine is adequate for most instruments. However, if this 
drying routine does not properly dry the sample card, run the Drying Calibration function.

From the “Options” menu, choose Drying Calibration (Figure 35).

Figure 35.  Drying calibration option

Insert a new (unused), sample card into the Direct Detect™ instrument and select the 
“Begin Calibration” button. Wait for the drying calibration to complete before removing 
the sample card.

Figure 36.  Drying calibration dialog

When the drying calibration is complete a message will indicate the new drying threshold 
value that will be used for the instrument. The default value is 0.3.

Figure 37.  Drying calibration complete
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4.2	 Creating a Calibration Method

4.2.1	 Calibration Mode
To create a calibration method you will first need to gather sample card spectra from 
known concentrations of proteins. To gather these files select “Calibration mode (no 
analysis)” from the “Options” menu (Figure 38). In “Calibration Mode (no analysis)”, the 
main screen is modified to enable sample acquisition with no analysis. These samples are 
then used to create new calibration method files.

Figure 38.  Calibration mode

The calibration methods drop down list is replaced with the “Sample Path” field. This is a 
folder where all sample files acquired will be stored. Use the button to the right of the field 
to select the path to store the files.

Because all files measured in this mode will be stored in the same path, it is recommended 
that the samples names for each sample position be unique.

Prepare and measure sample cards as you would normally. Samples files will be stored in 
the selected path, and no analyses will be performed on the samples. The results are not 
displayed and no data is stored in the database for the current user.

To create a robust method you need a number of different samples covering the entire 
range of concentration values you expect to measure (e.g., 0.2–5 mg/mL). This includes 
multiple samples that are of the same (or very close) concentration values. A sample set of 
20–30 files is generally acceptable for a good calibration method.

4.2.2	 Calibration Method
The Calibration Method function is used to create or modify calibration method files that 
will be used to perform the analysis of the sample cards. 

Choose “Calibration Method” from the “Options” menu. This opens a wizard that will walk 
you through the steps of creating or modifying a calibration method file. 

NOTE: Calibration method files have the file name extension “q3”.
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On the first screen of the wizard you decide whether to create a new method or modify an 
existing method.

Figure 38.  Calibration method first screen

The left side of the screen has options for creating or modifying methods. The center of the 
screen displays a list of method files that exist in the method path. The right side displays 
information about the selected method file.

The “Path containing method files” field displays the current path to store calibration 
method files. By default this is located in “Libraries” (Libraries\Documents\My Documents\
Direct Detect\Methods).

Select the path button to select a different path to store the calibration method files.

Use the reset button to return to the default path.

Creating a new calibration method:
To create a new calibration method file, select the option, and then 
select the “Next >>” button to continue to the next screen of the wizard.

Modifying an existing calibration method:
To modify an existing method file select the file from the “Existing Method Files” list. Then 
select the option . The spectra files previously used to create this 
method must still reside in the same path as they existed when the calibration method was 
first created.

Deleting an existing calibration method:
To delete a method from the list, first select it and then select the
button. This will delete only the calibration method file and not the “Calibration Mode” 
sample files that were used to create the method.

4.2	 Creating a Calibration Method, continued
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On the second screen of the Calibration Method wizard you select the previously 
measured sample spectra files and assign the known concentration values for each sample.

Use the button to open a standard file selection dialog. Select the sample 
files you want to include in this calibration method. The file names and path are added to 
the table of files.

Figure 39.  Calibration method sample selection

Keep in mind that in order to create a robust method you need a number of different 
samples (20–30 files) covering the entire range of concentration values you expect to 
measure.

Select using the Ctrl or Shift keys one or more files to remove from the list and then select 
the button.

To remove all the samples from the table, select the button.

With sample files selected you must enter the known concentration value for the measured 
sample in the “Conc” column of the table.

When all samples and concentration values have been entered select the “Next >>” button 
to continue to the next step of the calibration method wizard.

4.2	 Creating a Calibration Method continued
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The “Calibrate Samples” screen of the Calibration Method wizard calculates the ideal fit 
for the samples you selected.

Select the button to begin the line fitting routine. 

When the calibration is complete the results are listed in the table, as well as being plotted 
against the ideal line.

Figure 40.  Calibration method calibrate screen

In a perfect calibration every point would intersect the line exactly. The correlation 
coefficient listed about the plot (R2) would be “1.000”. 

In a good calibration each sample point would be on or near the ideal line. The plot in 
Figure 40 has a very good correlation coefficient (0.9913), while the plot in figure 41 has a 
poor correlation coefficient (0.4404).

Figure 41.  Bad correlation plot

Typically there will be one or two outliers or samples that are far from the ideal line. This 
can be caused by a bad sample measurement or an incorrect “Conc” value entered in the 
previous wizard screen.

Use the “<< Back” button to return to the previous wizard screen. Remove the bad samples 
and try to calibrate again.

4.2	 Creating a Calibration Method, continued
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Above the table of concentration/signal values, you can select one of three possible 
analysis types.

Figure 42.  Analysis type

Each analysis type corresponds to a calibration curve (NIST BSA AM1.q3, NIST BSA AM2.
q3, or NIST BSA AM3.q3) appropriate for the type of sample analyzed. The three curves 
compensate for spectral differences and buffer interference by applying different modes of 
integration. The graphic shows how the peak region for each mode is integrated.

NIST BSA AM1.q3

Method 1 relies on amide peak intensity relative to the local baseline 
(between predetermined wavenumbers). This method should be used 
for the analysis of samples where there is no buffer interference and 
the amide peak is well defined.

NIST BSA AM2.q3

Method 2 allows concentration determination in the presence of 
interfering buffers (e.g., Tris). The method uses amide signal intensity 
at a predetermined wavenumber (local baseline established as in 
Method 1). This method should be used for analysis of samples in 
buffer that contains interfering components.

NIST BSA AM3.q3

Method 3 compensates for spectral inconsistency to the right of amide 
signal. Signal intensity is measured at a predetermined wavenumber 
and the baseline is ‘anchored’ at a higher (to the left) wavenumber. 
This method is recommended for quantification of peptides.

Select the analysis type that best corresponds to the analyzed samples. 

When you are satisfied with the results of the calibration select the “NEXT >>” button to 
continue to the next screen of the calibration method wizard.

4.2	 Creating a Calibration Method, continued
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The final screen of the Calibration Method wizard stores the method file as a file.

Figure 43.  Calibration method save screen

A list of existing methods is displayed for reference.

If you are creating a new method you must enter a unique name for the method file (file 
naming restrictions apply).

If you are modifying an existing method then you cannot modify the method name.

In either case you can add or modify a description for this method. Use multiple lines for 
your description.

Use the button to save or overwrite the calibration method file.

Select the button to exit the Calibration Method wizard.

Select the button to return to the start of the wizard to begin another 
calibration.

4.2	 Creating a Calibration Method, continued
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5	Diagnostics
For additional information on diagnosing instrument issues, refer to section 11, Troubleshooting, in the 
Direct Detect™ Spectrometer User Guide.

5.1	 Hardware Diagnostics

The hardware diagnostics icon provides a quick visual indication of the state of 
the instrument’s hardware diagnostics. When no warnings or errors are present 
the icon is green with a green checkmark.

A yellow hardware diagnostics icon indicates some warning condition is present. 
Under most conditions this does not prevent the user from performing sample 
acquisition and analysis. If the warning indicates that the instrument warm-up 
period is active then measurement will not be allowed until the warm-up is 
complete.

A red hardware diagnostics icon indicates a critical failure in a hardware 
component. A source error can usually be corrected by replacing the NIR source 
element. Other types of hardware errors may require instrument repair.

Placing the mouse cursor over the icon displays a tooltip with 
simple information about the hardware diagnostics state.

Click on the icon to display the hardware diagnostics dialog 
which contains more detailed diagnostics information and 
allows you to create a hardware diagnostics report.

The hardware diagnostics dialog displays a row of icons indicating the state of the various 
hardware components of the instrument. Each icon indicates whether the component is 
good, reporting a warning, or reporting an error.
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Figure 44.  Hardware diagnostics source warning

Figure 44 shows the hardware diagnostics screen when the main icon is displaying a 
warning. In this example the instrument’s NIR source is indicating that it is nearing the 
end of its operational lifetime. Sample measurements can still be made and acquired 
however performance may suffer and the values for concentration may become suspect. 
If you receive this warning the source element should be replaced as soon as possible. 
Refer to section 12.1 of the Direct Detect™ Spectrometer User Guide for instructions on 
replacing the NIR source.

In Figure 45 the hardware diagnostics is reporting an error with the source and the status 
message indicates that the source is not connected. This generally means that source 
element is broken and needs to be replaced.

Figure 45.  Hardware diagnostics source error

Figure 46 indicates a warning involving the interferometer components. In this example 
the status message is indicating that the internal humidity of the instrument is too high. 
This typically means that the internal desiccant pack needs to be replaced.

5.1	 Hardware Diagnostics, continued
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Figure 46.  Hardware diagnostics interferometer warning

Select the save button to save a hardware diagnostics report file to the 
hard drive.

Select the print button to print the report (Figure 47) to an installed printer.

Figure 47.  Hardware diagnostics report

5.1	 Hardware Diagnostics, continued
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5.2	 Instrument Validation

The instrument validation icon provides a quick visual indication of the state of 
the instrument’s operational validation status. When no warnings or errors are 
present the icon is green with a green checkmark.

A yellow validation icon indicates one of the validation tests has expired. Sample 
measurement and analysis is still possible when a validation warning is present, 
however your laboratory practices may require that a new test be performed 
before continuing to measure samples.

A red validation icon indicates one of the validation tests failed its last 
measurement. Sample acquisition and analysis is not allowed if a failure has 
been reported. A failure can indicate the need for instrument service or repair.

Placing the mouse cursor over the icon displays a tooltip with simple 
information about the validation state. 

Click on the icon to display the instrument validation dialog which 
contains more detailed information.

Figure 48 shows the Instrument Validation dialog. The dialog displays identical controls 
for two different types of tests. Both tests display the status of the tests. Typically this is 
the amount of time until the test expires, or the amount of time since the test expired.

Figure 48.  Instrument validation dialog
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The Performance Qualification (PQ) test is a test that is typically performed daily. This test 
compares the performance of the instrument from day to day. A failure of this test may 
indicate a failure or performance drop in one of the system components (e.g., the source 
may be degrading).

The Operational Performance (OQ) tests the basic performance characteristics of the 
instrument. This test is typically performed annually. A failure of this test can indicate a 
hardware misalignment or failure.

A user with administrative privileges can perform these tests using the
buttons. Select either or both of the tests to perform. If you select the other test while one 
test is active, the software will start the second test as soon as the first test is complete. 
You can choose to abort the test before it begins.

Important: Do not insert a sample card while either of the validation tests is running.

Figure 49 shows the PQ test running. The status field turns yellow and displays which 
portion of the test is currently in progress. A progress bar indicates the percentage to 
completion for the entire test.

Figure 49.  PQ test active

To abort the test in progress, select the button. You will have to wait until 
the current segment of the test has completed. Generally it is not advisable to abort a test 
in progress since this will result in a test failure condition which will prevent sample 
measurement and acquisition.

If you selected a second test to start while the first test is active, and then abort the 
second test before it has begun, then the test will not be run and the status will remain 
the same.

5.2	 Instrument Validation Diagnostics, continued
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You can select the button to display the last PQ or OQ test report. Reports 
are stored in the program installation directory under the path “Validation\Reports”. This 
button will display only the most recent report (Figure 50).

Figure 50.  Validation PQ test report

OVP - PQ Test Protocol
Company:
Operator:
Instrument Type:
Optics Configuration:
Accessory:
Instrument Serial Number:
Instrument Firmw are Version:
OPUS/DB Version:
Overall Test Result
Test expires:
Test Date/Time:
Test Spectra Path:
Date of last PQ Reference Measurement
Comment:

MILLIPORE
Default
Alpha Sample Compartment RT-DLaTGS ZnSe
Fibre 1 w ith: MIR, KBr, RT-DLATGS [Internal Pos.1]
Millipore Direct-Detect
M3
1.320_MDD_01 Oct 27 2011
OPUS 7.0 Build: 7, 0, 122 / DB: 7.0.105.1106 for OPUS 7.0
PASSED
12/25/2011, 3:12:41 PM (GMT-5)
12/15/2011, 3:12:41 PM (GMT-5)
C:\Direct Detect\Validation\Data\20111215\151241

Signal to Noise Test

Minimum Signal to Noise Limit(area 1): 1000 Signal to Noise measured: 3458

100% Line Test

Maximum 100% Line Deviation: 2.0 Measured 100% Line Deviation: 0.29

Wavenumber Accuracy Test - Polystyrene (35.5 Deg. C, Peak is T. corr.)

Sample Material:
Specified Peak:
Measured Peak:
Corrected Peak:

1601.45 cm-1
1601.13 cm-1
1601.25 cm-1

Polystyrene
Maximum Deviation:

Measured Deviation:

0.50 cm-1

0.20 cm-1

Overall Test Result = PASSED

Date and Signature                                            Date and Signature

     
                  

6	 File Menu
This section explains the options on the “File” menu of the main program screen.

6.1	 Print Loaded Record

Figure 51.  File menu

This option prints the single sample card measurement report for the currently loaded 
sample results. This is either the last measurement and analysis performed, or the result 
loaded from the database using the “Load Record” button (section 3.1).

Use the hot key combination Ctrl-P to select this option, or use the “Create Report” button 
on the “Last Sample Results” tab (section 2.4).

5.2	 Instrument Validation, continued

Direct Detect™ Spectrometer Software User Guide 35



Selecting the “Print Loaded Record” option displays a report options dialog.

Figure 52.  Report options dialog

You can print the report to a printer or file (as a PDF report), or “print preview” the report.

You can also choose which plot to include with the report; either the spectrum plot or the 
calibration curve plot.

Select the button to print to the selected location.

6.2	 Logout
Select this option (Ctrl-L) to exit the main program screen and return to the login screen. 
This is recommended whenever the user plans to leave the instrument unattended for long 
periods, or to switch users.

6.3	 Exit
Select the exit option to close down the program without returning to the login screen.

7	Options Menu
7.1	 Program Settings

The options menu is divided into two sections. The bottom section is available only to users 
with administrator privileges. Refer to section 1.2 for information about administrative 
functions.

Figure 53.  Options menu

6.1	 Print Loaded Record, continued
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The Program Settings option displays a dialog with two tabs; one for user specific settings, 
and one for global (all users) settings (Figure 54). Each user has settings that can be 
customized for them.

Figure 54.  Program settings - User

Number of measurements to average:
This is the number of consecutive measurements that will be performed for each sample 
position measured. By default only one sample acquisition is performed. Increasing this 
number will result in multiple acquisitions which will be averaged before the analysis is 
performed.

Display blank measurements in history:
Normally the blank positions are not displayed in the top section of the “Card History” tab. 
Select this option to display the blank positions as well as the sample positions. This will 
also result in the blank measurement being plotted to the “Spectrum Plot” tab.

Some message boxes will have an option to not show the 
message again. Select this button to reset these messages 
so that they will be shown.

Only users with administrative privileges can modify the settings in the Global Settings 
tab of the Program Options dialog (Figure 55).

Figure 55.  Global settings Options 1

7.1	 Program Settings, continued
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The global settings are divided into two tabs labeled “Options 1” and “Options 2”.

Root Storage Path for Files:
This is the root path for storing all sample files measured during normal acquisition and 
analysis.

The default path is located in the “Libraries” folder.

“Libraries\Documents\My Documents\Direct Detect\”

Use the selection button to select a different root path if desired. The actual path for 
stored sample files depends upon the user and date and time of the measurement  
(section 9.2).

Use the reset button if you made changes to the path and want to return to the 
default path.

Drying Cycle:
The drying cycle section contains the parameters for performing the drying cycle part of 
the measurement.

Threshold: This is the threshold for the drying routine. Normally this is set by using 
the “Drying Calibration” function of the “Options” menu.

Cycles: The number of consecutive cycles that must be dry before the routine 
succeeds.

Attempts: The number of cycles that will be performed before the user is warned 
that the drying routine is not complete. You can increase this value if you routinely 
require more than one cycle to complete the drying.

Reference Measurement:
The system performs a reference measurement when the main screen is first displayed, and 
then again at periodic intervals.

Interval between reference measurements: This is the interval (in minutes) between each 
successive reference measurement.

Measure: This button allows you to perform a reference measurement immediately. This is 
useful if you change the interval and want to start the measurements immediately.

Measurement:
Number of Scans: Increase the number of scans to increase the signal-to-noise ratio of 
samples. This will result in longer acquisition times. It is not recommended that you reduce 
the number of scans below the default value of 6.

7.1	 Program Settings, continued
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The “Options 2” tab (Figure 56) contains a table which allows you to customize the tabs 
displayed on the “Spectrum Plot” tab of the main screen.

Figure 56.  Global settings Options 2

A default set of tabs and ranges are provided. Use the “Reset to defaults” button to reset 
this table to the defaults at any time.

To disable any of the defined tabs uncheck the box in the “Enabled” column.

To delete a row permanently, select the desired row(s) and press the keyboard “Delete” key.

Enabled: Check this column to display this tab.

Tab Name: Name that appears on the tab.

Title: Title for the plot.

X-Min: Minimum x-axis range of plot.

X-Max: Maximum x-axis range of plot.

Interval: The increments between intervals along the x-axis.

A maximum of ten tabs can be defined.

7.2	 Clear Results
Select this menu option to clear the “Last Sample Results” and the spectrum and curves 
plots.

7.3	 Select Blank File
When selecting the “Use Last Blank” option on the main screen (section 2.2), the last 
measured blank is used as the blank measurement for all future measurements. Use this 
option to select a previously measured blank file from a list.

7.1	 Program Settings, continued
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A dialog containing a list of all blank files measured by the current user is presented, with 
the most recently measured blank at the top of the list.

Figure 57.  Select blank dialog

Select an entry from the list and press the button. The dialog will close and the 
“Use Last Blank” option will be automatically selected.

7.4	 Plotting
The options on this menu mimic the options presented when right-clicking on the 
“Spectrum Plot” tab. Refer to section 2.5 for more information.

8	Help Menu
8.1	 User Guides

Select “Software User Guide” from the “Help” menu or use the hot key combination 
Ctrl+F1 to display the software user guide, or select “Direct Detect User Guide” (hot key 
combination Ctrl+F2) to display the spectrometer user guide.

Figure 58.  Help menu

Software User Guide            Ctrl+F1

Direct Detect User Guide     Ctrl+F2

About

?

?

8.2	 About
Select “About” from the “Help” menu to display a dialog containing information about the 
software and hardware.

This dialog can also be accessed using the logo button in the upper right corner of 
the main screen.

7.3	 Select Blank File, continued
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9	Appendix
9.1	 Software Updates

Direct Detect™ software may be updated periodically. For information on the most up-to-
date software, go to www.millipore.com/directdetect. Register your instrument in order to 
receive notification about relevant software upgrades.

9.2	 Folders and Files
Assorted files and folders are created by the software during sample acquisition and 
analysis. A defined structure must be maintained for the software to be able to function 
properly. The sample files can be backed up and restored as needed as long as the entire 
folder/file structure is maintained.

By default all files and folders are stored in the root file storage path defined in the global 
settings (section 7.1).

Folders:
By default the root file storage path is in the “My Documents” folder in “Libraries” 
(Libraries/Documents/My Documents/Direct Detect).

Figure 59.  File and folder structure

Folders are defined follows:

Direct Detect: Under the root folder “My Documents” is the folder called “Direct 
Detect”. All files and folders created by the software will be created in this folder.

Note: If an error log is generated it will be stored in this folder.

Methods: The methods folder contains the calibration method files used for sample 
analysis. These files have a “q3” file extension.

Spectra: All sample files are stored in the “Spectra” folder. 

Operator: A sub folder is created for each user as they log into the program. The 
folder name is the same as the user name.

Direct Detect™ Spectrometer Software User Guide 41

http://millipore.com/directdetect


9.2	 Folders and Files, continued

20120208: Each sample set is stored under a subfolder which is based upon 
the date of the sample acquisition (YYYYMMDD). In this example the date of 
acquisition was February 8, 2012.

132818: The actual sample files for each sample card measured are stored in a 
time-based folder. The time is the start of the sample measurement cycle. In this 
example the measurement cycle started at 13:28:18 (HH:MM:SS). The time value is 
24 hour format, so 1:28 PM is 13:28.

Files:
DDUserData.mdb: This is the user-specific database file which contains all the 
records displayed on the “Card History” tab on the main screen.

LastBuffer.0: This is a copy of the last blank measured. This is what is used when 
the option to “Use Last Blank” is selected.

Sample 1.2.0: The sample and blank file names are divided into three sections 
separated by decimal points: 

{Sample Name}.{Card Position}.{Type}

Sample Name = The sample name defined by the user for this sample position.

Card Position = The sample card position for this sample (1-4).

Type = ‘0’ is the original file and ‘1’ is the file modified during analysis.

For blank measurements the ‘Type’ is always ‘1’.

10	 Technical Service
For more information, contact the office nearest you. In the U.S., call 1-800-MILLIPORE  
(1-800-645-5476). Outside the U.S., go to our web site at www.millipore.com/offices for up-to-date 
worldwide contact information. You can also visit the tech service page on our web site at  
www.millipore.com/techservice.

11	 Standard Warranty
The applicable warranty for the products listed in this publication may be found at  
www.millipore.com/terms (within the “Terms and Conditions of Sale” applicable to your purchase 
transaction).
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